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Overview

This section discusses the following topics:
• Comtrol Drivers Management Console
• Supported Operating Systems
• Products Supported
• Conventions on Page 6
• Downloading the Latest Software and User Guides on Page 7

Comtrol Drivers Management Console

This User Guide discusses how to install and configure Comtrol device drivers 
using the Installation Setup Wizard and the Comtrol Drivers Management Console 
for the device driver.
The Comtrol Drivers Management Console is accessible through the Windows 
Control Panel using a dedicated shortcut created during the initial device driver 
installation process. The Comtrol Drivers Management Console allows you to 
browse all installed and supported Comtrol products in one place and apply any 
changes quickly.
Note: This User Guide discusses Comtrol adapters, see the DeviceMaster Device 

Driver User Guide for Windows for DeviceMaster specific information.
You can refer to Using the Comtrol Drivers Management Console on Page 28 for 
general information about the Comtrol Drivers Management Console.

Supported Operating Systems

The Comtrol Drivers Management Console supports the following operating 
systems:
• Windows 7
• Windows Server 2008
• Windows Vista
• Windows Server 2003
• Windows XP
RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A Overview - 5



 Overview 
Products Supported

These are the products supported by the Comtrol Drivers Management Console:
• DeviceMaster PRO
• DeviceMaster RTS
• DeviceMaster Serial Hub
• DeviceMaster 500
• RocketModem IV
• RocketPort EXPRESS
• RocketPort EXPRESS SMPTE
• RocketPort INFINITY
• RocketPort Plus Universal PCI
• RocketPort Plus/422 Universal PCI
• RocketPort Universal PCI
• RocketPort Universal PCI SMPTE

Conventions

In the remainder of this User Guide, the products are referred to accordingly:
• Comtrol device unless there is model-specific information
• DeviceMaster means the DeviceMaster models listed in the previous 

subsection
• RocketPort means any RocketPort model
• RocketPort EXPRESS/INFINITY means RocketPort EXPRESS, RocketPort 

EXPRESS SMPTE, and RocketPort INFINITY
• RocketPort and RocketModem (Universal PCI) means RocketModem IV, 

RocketPort Universal PCI, RocketPort Plus Universal PCI, RocketPort Plus/
422 Universal PCI, and RocketPort Universal PCI SMPTE

The paths in this Guide to locate DeviceMaster software and documentation point 
to the DeviceMaster RTS paths on the ftp site. All supported DeviceMasters 
(Products Supported) models use the same software and documentation.
6 - Products Supported RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A
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Downloading the Latest Software and User Guides

You can use the CD or the following tables to locate the latest version of the 
software and documentation for the appropriate product.
• RocketPort EXPRESS/INFINITY (below)
• RocketPort and RocketModem (Universal PCI) on Page 8

RocketPort 
EXPRESS/INFINITY

The following tables provide a quick reference to locate and download the latest 
software and documentation.

Software or Document Description

Device Driver

The device driver supports:
• Windows 7
• Windows Server 2008
• Windows Vista
• Windows Server 2003
• Windows XP

User Guide for Windows
(this Guide) This User Guide supports all Comtrol adapters in 

the Comtrol Drivers Management Console.

Bootable Diagnostics You can download and create a bootable Diagnostics 
CD if you cannot locate the CD shipped with your 
product.

Comtrol Utility You can use the Comtrol Utility to test or monitor 
ports. The Comtrol Utility includes Test Terminal 
and Port Monitor.

RocketPort EXPRESS 
User Guide This User Guide provides adapter and interface 

installation procedures. It also provides information 
about connecting serial devices.

RocketPort EXPRESS 
SMPTE User Guide This User Guide provides adapter and interface 

installation procedures. It also provides information 
about connecting serial devices.

RocketPort INFINITY 
User Guide This User Guide provides adapter and interface 

installation procedures. It also provides information 
about connecting serial devices.
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RocketPort and 
RocketModem 
(Universal PCI)

The following tables provide a quick reference to locate and download the latest 
software and documentation.

Software or Document Description

Device Driver

The device driver supports:
• Windows 7
• Windows Server 2008
• Windows Vista
• Windows Server 2003
• Windows XP

User Guide for Windows
(this Guide) This User Guide supports all Comtrol adapters in 

the Comtrol Drivers Management Console.

Bootable Diagnostics
RocketPort Universal PCI, RocketPort Plus/
422 Universal PCI, and RocketPort Universal 
PCI SMPTE:
You can download and create a bootable Diagnostics 
CD to test your adapter.

Bootable Diagnostics RocketModem IV:
You can download and create a bootable Diagnostics 
CD to test your adapter.

Comtrol Utility You can use the Comtrol Utility to test or monitor 
ports. The Comtrol Utility includes Test Terminal 
and Port Monitor.

RocketPort Universal PCI 
User Guide This User Guide provides adapter and interface 

installation procedures. It also provides information 
about connecting serial devices.

RocketPort Plus 
Universal PCI User 
Guide

This User Guide provides adapter and interface 
installation procedures. It also provides information 
about connecting serial devices.

RocketPort Plus/422 
Universal PCI User 
Guide

This User Guide provides adapter and interface 
installation procedures. It also provides information 
about connecting serial devices.

RocketPort Universal PCI 
SMPTE User Guide This User Guide provides adapter and interface 

installation procedures. It also provides information 
about connecting serial devices.

RocketModem IV 
Hardware Installation This document provides adapter installation 

procedures. It also provides basic AT commands 
information.
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 Device Driver Installation

This section discusses the following topics:
• Overview of the supported products
• Installation Setup Wizard on Page 16 for initial installation procedures
• Checking the Device Driver Version on Page 21
• Updating the Driver on Page 21
• Adding an Adapter (Existing Installation) on Page 26

Overview

Use the following procedure to install the device driver for Windows for the 
following Comtrol products using the Installation Setup Wizard:
• RocketModem IV
• RocketPort Universal PCI
• RocketPort Plus Universal PCI
• RocketPort Plus/422 Universal PCI
• RocketPort Universal PCI SMPTE
• RocketPort EXPRESS
• RocketPort EXPRESS SMPTE
• RocketPort INFINITY
Note: The above adapters are typically referred to as the RocketPort in this 

section, unless there is model-specific information.
If there is a device driver already installed on your system for the RocketPort, see 
Updating the Driver on Page 21 or Adding an Adapter (Existing Installation) on 
Page 26.
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Installation Setup Wizard

You can use the following procedure to install the device driver and the Comtrol 
Drivers Management Console, which is used to configure the driver.
1. Locate the latest driver assembly (.exe) for your product and copy it to a 

location that is available to the host.
You can use one of the following methods to access the latest driver:
• Download the latest device driver for your adapter.
• The Software and Documentation CD contains all of the files for 

installation, configuration, and troubleshooting. The CD also provides 
download links to the Comtrol ftp site to locate the latest files.

2. Close any applications that are using serial ports before the device driver 
installation.

3. Install the adapter and connect the interface (Quadcable, Octacable, or 
interface box). If you need hardware installation procedures, see Downloading 
the Latest Software and User Guides on Page 7) to locate the User Guide for 
your adapter type. 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The RocketPort default 
port setting is RS-232, except for SMPTE models, which are set to RS-
422. 

4. Click Cancel if a Found New Hardware message appears.

5. Start the installation by executing the appropriate .exe file for your adapter.
Driver assembly file names include the driver version number. 
For example, RocketPort_RocketModem_Windows_x.xx.exe or 
RP_EXPRESS_INFINITY_Windows_x.xx.exe, where x.xx is the driver assembly 
version.

Caution
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6. Click Next to start the installation process.

Note: This screen shot displays a RocketPort EXPRESS/INFINITY 
installation. The RocketPort Universal PCI series/RocketModem IV 
installation displays as the RocketPort/RocketModem Installation 
Setup Wizard.

7. Optionally, enter a different location to install the driver files.

Note: The RocketPort/RocketModem (Universal PCI bus) default installation 
location is Program Files\Comtrol\RocketPort.
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8. Click Install.

9. Leave the Launch RocketPort EXPRESS/INFINITY or RocketPort/RocketModem 
Driver Installation box checked and click Finish.

If you do not check this box, you can use the shortcut under the Start button at 
the location for your adapter type to start the driver installation:
• Programs> Comtrol> RocketPort EXPRESS INFINITY> Driver Installation 

Wizard

• Programs> Comtrol> RocketPort> Driver Installation Wizard - RocketPort and 
RocketModem (Universal PCI)
18 - Installation Setup Wizard RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A
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10. Click Next to install the driver.

11. Click Install and Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Click Next.
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13. Click Proceed.

Note: The RocketPort and RocketModem (Universal PCI) Driver Package is 
displayed as RocketPort and the Device(s) display as RocketPort and  
RocketModem Boards.

14. Click the Launch Comtrol Drivers Management Console button.
15. Return to the Installation wizard and click Close to exit the wizard.

16. Go to Configuring COM Port Properties on Page 35 to configure the COM port 
properties for RocketPort adapters or see Verifying and Testing RocketModem 
IV Adapters on Page 35 to verify the RocketModem IV installation.

17. If desired, go to Configuring Device Properties on Page 33 to set up advanced 
device properties (device name and starting COM port number).

After driver installation and configuration, connect the serial devices to the ports. 
For information about the RocketPort connectors, refer to the appropriate User 
Guide (Page 7).
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Checking the Device Driver Version

Use the appropriate procedure for your operating system to check the Comtrol 
device driver version using the Device Manager.
1. Access the Device Manager:

• Windows 7 and Windows Vista: Right-click Computer, click Manage, and 
then highlight the Device Manager.

• Windows Server 2008 R2: Click Start, right-click Computer, and then click 
Properties.

• Windows Server 2003: Right-click My Computer, click Manage, and then 
click the Device Manager button.

• Windows XP: Not logged into a domain controller: Right-click My Computer, 
click Manage, and then highlight the Device Manager.

• Windows XP: Logged into a domain controller: Right-click My Computer, 
click Manage, and then click the Device Manager button.

2. Expand the Multi-port serial adapters entry, right-click the Comtrol device 
that you want to configure, and then click Properties.

3. Click the Driver tab to view the device driver version.
You can check this driver version against the latest driver for your product.
If necessary, you can update the device driver using the next subsection.

Updating the Driver

Use the following procedure to update the RocketPort device driver after initial 
installation.
1. Locate the latest device driver assembly (Page 7) and copy it to a location that 

is available to the host.
2. Close any applications that are using serial ports before the device driver 

installation.
3. Start the update by executing the .exe file.
4. Click Next to start the Installation Setup Wizard.
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5. Optionally, enter a different location to install the latest device driver files.

Note: RocketPort/RocketModem (Universal PCI bus) default installation 
location is Program Files\Comtrol\RocketPort.

6. Click Install.
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7. Leave the Launch RocketPort EXPRESS/INFINITY or RocketPort/RocketModem 
Driver Installation box checked and click Finish.

If you do not check this box, you can use the shortcut under the Start button at 
the location for your adapter type:
• Programs> Comtrol> RocketPort EXPRESS INFINITY> Driver Installation 

Wizard

• Programs> Comtrol> RocketPort> Driver Installation Wizard - RocketPort and 
RocketModem (Universal PCI)

8. Click Next to update the driver.
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9. Click Update and Next.

10. Click Next to update the driver.
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11. Click Proceed.

12. Click the Launch Comtrol Drivers Management Console button to configure the 
ports or device properties.
Note: The RocketPort and RocketModem (Universal PCI) Driver Package is 

displayed as RocketPort and the Device(s) display as RocketPort and 
RocketModem Boards.

13. Return to the Installation wizard and click Close.

14. If necessary, go to Configuring COM Port Properties on Page 35 to configure 
the COM port properties for RocketPort adapters or see Verifying and Testing 
RocketModem IV Adapters on Page 35 to verify the RocketModem IV 
installation.

15. If desired, go to Configuring Device Properties on Page 33 to set up advanced 
device properties (device name and starting COM port number).
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Adding an Adapter (Existing Installation)

Use the following procedure to add an adapter to an existing RocketPort 
installation.
1. Close any applications that are using serial ports before the device driver 

installation.
2. Install the adapter and connect the interface (Quadcable, Octacable, or 

interface box).
If you need hardware installation procedures, see Downloading the Latest 
Software and User Guides on Page 7). 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The default port setting 
is RS-232.

3. Click Cancel if a Found New Hardware message appears.

4. From the Start button, click:
• Programs> Comtrol> RocketPort EXPRESS INFINITY> Driver Installation 

Wizard 

• Programs> Comtrol> RocketPort> Driver Installation Wizard - RocketPort and 
RocketModem (Universal PCI)

Caution
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5. Click Next to start the Comtrol Driver Installation Wizard.

6. Click Install and Next.

7. Click Next and follow the Installation Wizard. Refer to Step 11 on Page 19, for 
the remainder of the installation steps if needed.
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Device Driver Configuration

This section discusses the following topics:
• Using the Comtrol Drivers Management Console on Page 27
• Configuring Device Properties on Page 32
• Configuring COM Port Properties on Page 34

Using the Comtrol Drivers Management Console

This subsection discusses basic Comtrol Drivers Management Console operations, 
such as:
• Accessing the Comtrol Drivers Management Console
• Displaying All Installed Devices on Page 27
• Expanding the View on Page 28
• How to Configure Device Properties on Page 28
• Customizing the Device Name on Page 29
• Customizing the COM Port Name on Page 29
• How to Configure COM Port Properties on Page 30
• How to Save Changes on Page 31
See Configuring Device Properties on Page 32 to start configuration procedures for 
your adapter.

Accessing the 
Comtrol Drivers 
Management 
Console

Accessing the Comtrol Drivers Management Console can be done using one of the 
following methods:
• Windows Control Panel; go to your Control Panel and click on the Comtrol 

Drivers Management Console.
•  Shortcut; located under Start> Program Files> Comtrol> 

- RocketPort [RocketPort/RocketModem (Universal PCI)]> Comtrol Drivers 
Management Console

- RocketPort EXPRESS INFINITY >Comtrol Drivers Management Console

Displaying All 
Installed Devices

The Comtrol Drivers Management Console opens and displays all products for 
which a device driver was installed. 
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Expanding the View To view a device or devices under a product family, click the + in the Tree View 
pane to open the selected family. 

How to Configure 
Device Properties

This overview discusses changing device properties for a product. Highlight the 
device name of the product that you want to configure in the Tree View pane. Make 
any necessary changes.
• Click Apply to save the changes, which saves the changes and leaves the 

Comtrol Drivers Management Console open.
• Click Ok to save the changes and close the Comtrol Drivers Management 

Console.
• Click Cancel to close the Comtrol Drivers Management Console without saving 

the changes.
If you click a port or device name without saving the changes, the Comtrol Drivers 
Management Console will prompt you to Apply, Ignore, or Cancel the changes.
For more information, see Configuring Device Properties on Page 32. 
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Customizing the 
Device Name

Change the default Device Name on the Device General tab by changing the name 
in the User-Friendly Device Name field and saving the change.

Customizing the 
COM Port Name

Change the default Port Name on the Port Settings General tab by changing the 
name in the User-Friendly Port Name field and saving the change.
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How to Configure 
COM Port 
Properties

To change a port’s properties for a product, highlight the port of the product that 
you want to configure in the Tree View pane. Make any necessary changes:
• Click Apply to save the changes, which saves the changes and leaves the 

Comtrol Drivers Management Console open.
• Click Ok to save the changes and close the Comtrol Drivers Management 

Console.
• Click Cancel to undo the changes and close the Comtrol Drivers Management 

Console.
If you click another port or device name without saving the changes, the Comtrol 
Drivers Management Console will prompt you to Apply, Ignore, or Cancel the 
changes.
For more information, see Configuring COM Port Properties on Page 34.
After saving the port changes, if desired, you can click Apply These Settings to All 
Ports to populate the remaining ports with these COM properties. 
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How to Save 
Changes

The Comtrol Drivers Management Console indicates that changes have been 
made on this screen with a red frame that identifies which device’s General tab you 
are editing.
• Clicking the Apply button saves the changes on the tab and leaves the Comtrol 

Drivers Management Console open for further configuration.
• Clicking the Ok button saves the changes on that tab and closes the Comtrol 

Drivers Management Console.
• Clicking the Cancel button cancels the changes on that tab and closes the 

Comtrol Drivers Management Console. 
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Configuring Device Properties

Use the following procedure to change device settings on an adapter 
1. Open Comtrol Drivers Management Console (Accessing the Comtrol Drivers 

Management Console on Page 27).
2. Highlight the adapter device name that you want to configure.

RocketPort/RocketModem (Universal PCI) Device General Tab

RocketPort EXPRESS/INFINITY Device General Tab
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3. If desired, change the User-Friendly Device Name.
4. If desired, set a Starting COM Port number value.
5. If this is RocketPort/RocketModem (Universal PCI), optionally, pick a different 

Scan Rate (ms) (Page 33).
6. Optionally, click Verbose Event Log if you want to log additional RocketPort 

information into the event log.
7. After making your changes, click Apply if you have additional configuration 

procedures or click Ok if you have completed configuring your Comtrol devices.
Note: If you do not Apply the changes, you will be prompted to Apply, Ignore, or 

Cancel the changes.
The following table provides detailed information about Device General tab options 
for the RocketPort.

Device General Tab Description

Device Name

This is the default name assigned by the driver and it 
cannot be changed. You can use the User-Friendly Device 
Name field to provide custom device names for your 
installation.

User-Friendly Device 
Name

Use this field to enter a more descriptive name. The name 
that you assign is not saved until you click Apply or OK.

Starting COM Port 
Number

You can change the starting COM port number in the drop 
list for this adapter.
In addition, you can use Starting COM Port to set 
nonsequential starting COM port numbers for each 
adapter, thus leaving gaps in the COM port numbering 
sequence.
When you change the starting COM port number, the 
driver assigns that COM port to the first port on this 
adapter and all other port numbers follow in sequence.
Do not overlap COM port numbers between devices or 
other adapters because if you do so, the overlapping ports 
are disabled.

Scan Rate (ms)]

(RocketPort/
RocketModem 
(Universal PCI))

Default = 10ms

Typically, you should leave the scan rate set to the default 
value (10 ms) for most applications. To adjust latency for 
time-critical applications, select a longer or shorter 
interval from the droplist, or type in the rate (2 to 50). If a 
value larger than 50 is entered, the maximum of 50 is 
implemented. 
Note: The faster the scan rate (lower number), the higher 

the load on the system processor.

Verbose Event Log

Default = Disabled

Selecting this option causes detailed messages to be sent 
to the operating system Event Log. This added information 
can be useful when debugging communications and 
configuration problems

Save Configuration
Click Save Configuration to save the Device Settings for 
use on another similar Comtrol device or to archive a copy 
of your environments settings.

Load Configuration

Click to Load Configuration to load the Device Settings 
previously saved using the Save Configuration feature.
Note: You cannot a load configuration file from different 

models. For example, you cannot load a 
configuration file for a RocketModem IV on a 
RocketPort EXPRESS or RocketPort Plus/422 
Universal PCI.
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Configuring COM Port Properties

This section discusses COM port configuration procedures for RocketPort ports. If 
you want to change the starting COM port number on the RocketPort, see 
Configuring Device Properties on Page 32.
If your application does not set COM port properties, use the Device Manager to 
access Ports (COM & LPT) to change the port parameters. If the application sets 
COM port properties, those settings take precedence over Windows COM port 
settings. The exception to this guideline is if you use the Override and Lock Baud 
Rate to option.
Use the following procedure to change COM port settings on a RocketPort port or 
ports.

Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the driver. The driver default port setting 
is RS-232.

1. Open Comtrol Drivers Management Console (Accessing the Comtrol Drivers 
Management Console on Page 27).

2. Highlight the appropriate RocketPort.
3. Highlight the first port you want to configure.

Ok Click Ok to save the changes made on this page and close 
the Comtrol Drivers Management Console.

Cancel Cancels any changes made on this page.

Apply
Click Apply to save the settings on this page. If you do not 
click Apply before leaving this page, you will be prompted 
to Apply or Cancel the changes.

Device General Tab Description

Caution

RocketPort/RocketModem (Universal PCI) Port General Tab
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4. RocketPort EXPRESS/INFINITY, select the appropriate communications 
mode.

5. Enable the features that you want to use.
Note: You can use the “What’s this?” help or refer to the following table for 

information about each option.
6. RocketPort EXPRESS/INFINITY, select the Use Fast (Low Latency) Data 

Transfer option when receiving or sending small blocks of data.
7. Optionally, click the RTS Toggle Options button:

• If your communications application does not toggle FTS when transmitting 
in RS-485 mode.

• If you are using an 
external RS-232 to 
RS-485 converter, 
which is attached to 
a port that is 
configured for RS-
232. 

a. Click the 
appropriate options 
for your 
environment.

b. Click OK to save 
the changes and 
return to the port 
General tab.

8. If desired, click the Clone check box to set all of the ports on this Comtrol 
device to these characteristics.

9. Optionally, change the User-Friendly Port Name.
10. If desired, select a different COM Name (COM port number). The drop-down 

list displays (in use) next to COM port numbers that are already in use in this 
system. Do not duplicate COM port numbers as this will cause the ports to not 
function.

RocketPort EXPRESS/INFINITY Port General Tab
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11. Click Apply to save these changes.
Note: If you selected RS-422 mode, make sure that there is not a device 

attached to the port and click Ok.
12. Highlight the next port that you want to configure and perform Steps 4 

through 11. 
The following table provides detailed information about the options on the port 
General tab.

Port Settings 
General Tab Description

RS Mode

(RocketPort 
EXPRESS/INFINITY)

Use this drop-down list to select the communications mode 
for the serial device that you will be connecting to this port.
• RS-232 (default RocketPort EXPRESS, RocketPort 

INFINITY, RocketPort Universal PCI, RocketPort Plus 
Universal PCI, and RocketModem IV)

• RS-422 (default RocketPort EXPRESS SMPTE, 
RocketPort Plus/422 Universal PCI, and RocketPort 
Universal PCI SMPTE)

• RS-485 Mode provides these choices:
- RS-485 2-wire (half-duplex) supports transmit and 

receive data. When data is transmitted, the 
Transmit Enable signal is activated, and the 
Transmit Receive device switches from receive to 
transmit automatically.

- RS-485 4-wire Master (full-duplex master) supports 
transmit and receive data, which means both 
signals are always active. The RocketPort 
EXPRESS/INFINITY is enabled by the Transmit 
Enable signal. This mode is the same as RS-422.

- RS-485 4-wire Slave (full-duplex slave) supports 
transmit and receive data. When data is 
transmitted, the Transmit Enable signal is 
activated, the Transmit device goes active and 
starts sending data. When the data is not being 
sent, the Transmit device is inactive. The Receive 
device is always active.

If you click RS-485, you may need to change settings in the 
RTS Toggle Options screen.
The default value is RS-232 for most RocketPort EXPRESS/
INFINITY models. The RocketPort EXPRESS SMPTE 
default value is RS-422.
Note: The RocketPort/RocketModem (Universal PCI) RS 

Mode is controlled by the attached interface.

Override and Lock 
Baud Rate to

Default = None

This option allows you to lock selected ports.
You can select a value from the drop-down list or enter an 
appropriate value from the following standard baud rates: 
300, 600, 1200, 1800, 2400, 3600, 4800, 7200, 9600, 14400, 
19200, 38400, 57600, 115200, 230400, 460800, or 921600. 
The Quad/Octacable models support up to 921.6Kbps and 
the 8/16/32-port models with an interface box support up to 
460.8Kbps.
After locking a baud rate, no matter what baud rate is 
selected in a host application, the actual rate used is the 
rate specified here.
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RTS Toggle Options

This button opens the RTS Toggle Options popup, which 
provides the following features:
• Override and Lock to RS-485 Toggle Mode 

Use the Override and Lock to RTS Toggle Mode option to 
lock the port in RTS (Request to Send) toggle mode, 
then set the mode (low or high) as desired for RS-485 
mode.

• RS-485 Toggle RTS Low 
Use the RTS Toggle RTS Low option to toggle the RTS 
output signal low during data transmission, which may 
be needed for relay devices for RS-485.
If the option box is not checked, RTS is toggled high 
(asserted) during data transmission for RS-485 mode.

• Defaults 
Clicking the Defaults button returns all the values in 
the RTS Toggle Options popup to their default state:
- Override and Lock to RTS Toggle Mode = Disabled
- RTS Toggle RTS Low = Disabled

Transmit Data 
Timeout Port Close

Default = 0

This option allows you to select the length of time to wait 
for data to clear the transmit buffer after a host application 
has closed the port. This is typically used with serial 
devices such as printers, to give the data sufficient time to 
flush through the system.

Map CD to DSR

Default = Disabled

This option is used in installations where there is no 
connection to the port’s DSR input.
Click this check box to cause the CD input to appear as 
DSR to the host application, and to perform hardware 
handshaking with CD rather than DSR.

Map 2 Stop Bits to 1

Default = Disabled

If your application is hard-coded to use two stop bits and 
you receive framing errors, click this check box to map 2 
stop bits to 1 bit. 
Leave this check box blank to enable stop bits to pass 
through unchanged.

Wait on Physical 
Transmission before 
Completing Write

Default = Disabled

This option forces all write packets to wait until the 
transmit data has physically completed the transmission 
before returning completion to the host application. 
The default mode (check box not clicked) is to buffer the 
data in the transmit hardware buffer, and return 
completion as soon as the packet is in the buffer.

Emulate Modem 
Hardware RING 
Signal

Default = Disabled

Click this check box to emulate the ring indicator signal. 
If this box is checked and the port receives a RING signal 
(or an alternate code, as defined in the AT command set for 
the modem), it sends an RI signal to the communications 
application.

Block PnP search for 
attached serial device

Default = Disabled

This option disables plug and play from searching for a 
device attached to the serial port.
For example, data received during device discovery on a 
device is assumed to be a mouse to plug and play.

Port Settings 
General Tab Description
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Clone: Apply all the 
settings to all ports

Default = Disabled

If this check box is not clicked, changes apply to the selected 
port only. 
If this check box is clicked, changes apply to all ports on 
this board.

Use Fast (Low 
Latency) Data 
Transfer

(RocketPort 
EXPRESS/INFINITY)

Default = Disabled

Use this option when you need to send or receive a small 
block of data on RocketPort EXPRESS/INFINITY adapters.

User-Friendly Port 
Name

You can enter a custom COM port name to identify this 
RocketPort in the Comtrol Drivers Management Console.

COM Name

The COM Name drop list allows you to renumber this COM 
port. If you see a COM port number followed by (in use), 
this means that Plug and Play sees those COM port 
numbers in use by another device.
If you rename the port to a COM name used by another 
port, a dialog appears indicating that the port is already in 
use.

Defaults

Default = Disabled
Click the Defaults button to return to the driver default 
values.

Port Settings 
General Tab Description
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Verifying and Testing RocketModem IV 
Adapters

If you have not done so, install the RocketPort and RocketModem (Universal PCI) 
device driver using the Installation Setup Wizard, Device Driver Installation on 
Page 15.
This section discusses the following RocketModem IV topics:
• Verifying the Modems Installed
• Testing the Modems on Page 40
• Testing RocketModem IV Ports on Page 42

Verifying the Modems Installed

To verify that the modems were detected and installed, perform the following 
steps:
1. Access the Windows Device Manager.

• Windows 7 and Windows Vista: Right-click Computer, click Manage, and 
then highlight the Device Manager.

• Windows Server 2008 R2: Click Start, right-click Computer, and then click 
Properties.

• Windows Server 2003: Right-click My Computer, click Manage, and then 
click the Device Manager button.

• Windows XP: 
Not logged into a domain controller: Right-click My Computer, click Manage, 
and then highlight the Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.
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2. Click the Modems folder, the modems should appear as shown below.

3. Highlight one of the modems and select Properties.

4. Check to see if the Microsoft Plug-N-Play has installed the modems in the 
correct order.
• If the order of the modems is not important, then you can go to Testing the 

Modems on Page 40.
• If the modems were in the order you would like them to be in, use the 

procedure below to reinstall the modems.
5. Configure the RocketModem IV ports to disable Plug & Play detection of serial 

ports.
a. Open the Comtrol Drivers Management Console.
b. Click one of the ports.
c. Check the Block Plug-N-Play Search for Attached Serial Device box.
d. Check the Apply These Settings to All Ports box.
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e. Click OK.

6. Go to the Control Panel and click Phone and Modem.
7. Select the Modems tab.
8. Select the modems you want to remove (most likely you will want to remove all 

of the modems).
9. Reboot the system.
10. After rebooting, return to the Control Panel and click Phone and Modem.
11. Select the Modems tab.
12. Select Add and Ok.

13. In the Add New Modem Wizard, check Don’t detect my modem; I will select it 
from a list.
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14. Click Have Disk.

15. Browse to \Program Files\Comtrol\RocketPort, highlight CTMAPORT.inf, and 
click Open. 
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16.  Highlight Comtrol RocketModem IV V.92 and click Next.

17. Select Selected ports, choose the COM port you want to associate with this 
modem, and click Next.

18. Select Finish then repeat this procedure for every modem you want to install.
19. Make sure you select the right COM port for each modem so they will be in 

order. 
RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A Verifying the Modems Installed - 39



 Verifying and Testing RocketModem IV Adapters 
Testing the Modems

You can use the following procedure to test modems.
1. Access the Windows Device Manager.

• Windows 7 and Windows Vista: Right-click Computer, click Manage, and 
then highlight the Device Manager.

• Windows Server 2008 R2: Click Start, right-click Computer, and then click 
Properties.

• Windows Server 2003: Right-click My Computer, click Manage, and then 
click the Device Manager button.

• Windows XP: 
Not logged into a domain controller: Right-click My Computer, click Manage, 
and then highlight the Device Manager.
Logged into a domain controller: Right-click My Computer, click Manage, 
and then click the Device Manager button.

2. Click the Modems folder, select one of the modems and chose Properties.
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3. Select the Diagnostics tab.

4. Click Query Modem.
RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A Testing the Modems - 41



 Verifying and Testing RocketModem IV Adapters 
5. The modem should respond to several commands issues by the Query 
command.

6. You can click View log to see all of the responses to the Query command.
7. Repeat the Query Modem command for each of the modems to verify that they 

respond.
This tests the ability for the device driver to communicate through the COM 
port or ports to the RocketModem IV and receive an intelligent response from 
the modem.
If this test fails, run the bootable RocketModem IV Diagnostics from a CD or 
bootable floppy diskette. If necessary, you can download the bootable 
Diagnostics from ftp://ftp.comtrol.com/html/RM4_diag.htm.

Testing RocketModem IV Ports

You can test the RocketModem IV using a terminal emulator such as the Comtrol 
Corporation’s Test Terminal (Wcom2) program or Hyperterminal. The following 
procedure shows using Test Terminal.
1. If necessary, install Test Terminal, Installing the Comtrol Utility on Page 53.
2. Stop all applications that may be accessing the ports such as RRAS or any 

faxing, or production software. See the appropriate help systems or manuals 
for instructions on stopping these services or applications. 
If another application is controlling the port, then Test Terminal will be unable 
to open the port and an error message will be shown.

3. Start Test Terminal (WCom2), from the Start menu, select Programs > Comtrol 
> Utilities > Test Terminal (WCom2).
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4. Select File > Open Port, the 
appropriate port (or ports) 
from the Open Ports drop-
down list and click Ok.

5. Type AT and press Enter.
All further commands should 
be followed by a (CR) (carriage 
return or Enter).
You should see a response of 
OK.
a. If you do not see the AT 

but you see the OK, type 
AT E1.

b. Type AT again.
You should then see the 
AT and the OK.

6. Type ATDT and a telephone number of a convenient phone.
You should observe the phone ringing. This shows that the RocketModem IV is 
capable of going Off Hook and dial a number.

7. Dial the telephone number of a modem you want to test. 
The word Ring should appear on the WCom2 screen each time the phone 
rings.
a. Type ATA to answer the call.

You should hear the modem try to synchronize with the telephone. If you 
are not using a modem to try to connect with the RocketModem IV, you will 
not be able to proceed further. 

b. Hang up the phone.
8. Type +++ in WCom2 to return the modem to command mode.   You will get an 

OK response.
9. Type ATH0 to hang up the modem.

This completes the RocketModem IV testing.
10. You are now ready to configure your communications application according to 

the operators manual and test the modems and phone lines using your 
application.
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Using Configuration Files

The Comtrol Drivers Management Console supports saving configuration files, 
which provides:
• Back-up for existing configurations
• Ability to configure multiple of the same devices with the same configuration 

parameters
Note: Configuration files must be for the same model with the same port density. 

For example, you cannot load a RocketPort EXPRESS configuration file 
onto a RocketPort EXPRESS SMPTE or a configuration file for a 32-port 
RocketPort INFINITY onto a 4-port RocketPort INFINITY.

Configuration files are saved with a .DCF extension.

Saving Configuration Files

Use the following procedure to create and save a configuration file.
1. After configuring the device and ports, click Save Configuration.
2. Optionally, change the default file name and click Save.

Loading a Configuration File

Use the following procedure to load a configuration file for your device. You must 
have previously saved a configuration file before you can load a configuration file.
1. In the left pane, click the device that you want to load the configuration file 

upon.
2. Click Load Configuration.
3. Browse to the location of the configuration file that you want to load.
4. Highlight the configuration file and click Open.
The configuration file will load in a few moments.
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Removing the Adapter and Driver

This section discusses:
• Removing a RocketPort from an installation without removing the device 

driver from your system
• Removing the Device Driver and Adapter from your system

Removing a RocketPort

Use the Device Manager if you want to remove a RocketPort from the Comtrol 
Drivers Management Console. You will need to close the Comtrol Drivers 
Management Console before you can remove a RocketPort.
You can use the appropriate discussion, to locate the procedure for your operating 
system.
• Windows 7 and Windows Vista
• Windows Server 2008 R2
• Windows Server 2003
• Windows XP on Page 54
Note: Administrative privileges are required to remove device drivers on Windows 

7, Windows Server 2008, and Windows Vista.

Windows 7 and 
Windows Vista

You can use this method to access the Device Manager to remove a RocketPort 
from the Comtrol Drivers Management Console.
1. Close the Comtrol Drivers Management Console.
2. Right-click Computer.
3. Click Manage and highlight Device Manager.
4. Expand the Multi-port serial adapters entry.
5. Right-click the RocketPort that you want to remove and click Uninstall.
6. Windows Vista users should click the check box to remove the software from 

the system on the last (or only) device.

Windows Server 
2008 R2

You can use this method to access the Device Manager to remove a RocketPort 
from the Comtrol Drivers Management Console.
1. Close the Comtrol Drivers Management Console.
2. Click Start, right-click Computer.
3. Click Properties.
4. Expand the Multi-port serial adapters entry, right-click the RocketPort that you 

want to remove and click Uninstall.

Windows Server 
2003

You can use this method to access the Device Manager to remove a RocketPort 
from the Comtrol Drivers Management Console.
1. Close the Comtrol Drivers Management Console.
2. Right-click My Computer, click Manage.
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3. Click the Device Manager button. 
4. Expand the Multi-port serial adapters entry, right-click the RocketPort that you 

want to remove and click Uninstall.

Windows XP You can use the appropriate method to access the Device Manager to remove a 
RocketPort from the Comtrol Drivers Management Console.

Not logged into a 
Domain Controller

1. Close the Comtrol Drivers Management Console.
2. Right-click My Computer.
3. Click Manage and highlight the Device Manager. 
4. Expand the Multi-port serial adapters entry, right-click the RocketPort that you 

want to remove and click Uninstall.

Logged into a 
Domain Controller

1. Close the Comtrol Drivers Management Console.
2. Right-click My Computer, click Manage, and then click the Device Manager 

button. 
3. Expand the Multi-port serial adapters entry, right-click the RocketPort that you 

want to remove and click Uninstall.

Removing the Device Driver and Adapter

Use the following procedure to remove the RocketPort EXPRESS/INFINITY 
device driver.
1. From the Start button, click the appropriate shortcut for your adapter:

• Programs>Comtrol>RocketPort EXPRESS INFINITY>Driver Installation 
Wizard 

• Programs>Comtrol>RocketPort>Driver Installation Wizard - RocketPort and 
RocketModem (Universal PCI)

2. Click Next to start the Comtrol Driver Installation Wizard.
3. Click Remove All and Next.
54 -  Removing the Adapter and Driver RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A



 Removing the Adapter and Driver 
4. Click Next to remove the driver.

5. Click Proceed to continue the driver removal process.
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6. Click the Reboot My Computer button or Close.

• If you click Close, make sure that you reboot the system and remove the 
adapter to complete the driver removal.

• If you click Reboot My Computer, click Ok. 

7. Shutdown the system and remove the RocketPort adapter.
8. If you want to totally remove the .exe driver assembly:

a. Delete any copies of the .exe driver assembly file residing on the system.
b. Delete the driver and devices using the Add> Remove Programs Control 

Panel.
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Troubleshooting and Technical Support

This section contains the following topics:
• Troubleshooting Checklist
• Comtrol Utility on Page 53

- Installing the Comtrol Utility on Page 53
- Using Port Monitor (PMon2) on Page 55
- Using Test Terminal on Page 58

• Before Calling Technical Support on Page 63
• Technical Support on Page 64

Troubleshooting Checklist

If you are having trouble with a RocketPort installation, try the following.
Note: Most customer problems reported to Technical Support are traced to cabling 

or network problems.

Issue Troubleshooting

Correct cabling?
Verify that you are using the correct types of cables in the 
correct places and that all cables are tightly connected. 
Refer to the appropriate RocketPort User Guide on the CD or 
download the latest version (Page 7) to verify cabling.

Correct Port 
Addressing?

Verify that you are addressing the port correctly. In many 
applications, device names above COM9 require the prefix 
\\.\ to be recognized. For example, to reference COM20, use 
\\.\COM20 as the file or port name.

Comtrol Drivers 
Management 
Console?

Verify that the RocketPort has installed using the Comtrol 
Drivers Management Console to confirm that the adapter 
displays. Install the device driver, if the adapter is not 
displayed.

Verify the 
Hardware?

Run the bootable diagnostics. 
• The RocketPort EXPRESS/INFINITY is shipped with a 

bootable CD that executes the hardware diagnostics. If 
you cannot locate the CD, you can download and burn 
the bootable Diagnostics CD.

• You can download and burn a bootable Diagnostics CD 
for the RocketPort and RocketModem (Universal PCI).

The appropriate RocketPort User Guide provides procedures 
about running the Diagnostics.

Test the Port or 
Ports?

Install the Comtrol Utility (Page 53) and use Test Terminal 
(Page 58).

Is this the Latest 
Driver? See Checking the Device Driver Version on Page 21.
RocketPort Series/RocketModem IV Driver User Guide: 2000564 Rev. A Troubleshooting and Technical Support - 51



 Troubleshooting and Technical Support 
Port Does Not 
Open?

1. Open the Device Manager. 
• Windows 7 and Windows Vista: Right-click 

Computer, click Manage, and then highlight the 
Device Manager.

• Windows Server 2008 R2: Click Start, right-click 
Computer, and then click Properties.

• Windows Server 2003: Right-click My Computer, 
click Manage, and then click the Device Manager 
button.

• Windows XP: 
Not logged into a domain controller: Right-click My 
Computer, click Manage, and then highlight the 
Device Manager.
Logged into a domain controller: Right-click My 
Computer, click Manage, and then click the Device 
Manager button.

2. Double-click Ports (COM & LPT) to expand the view.
Comtrol ports are displayed in the Device Manager, 
accordingly:
• DeviceMaster ports are Comtrol NS-Link ports
• RocketPort EXPRESS/INFINITY are Comtrol 

RocketPort Unity ports
• RocketPort and RocketModem (Universal PCI) are 

Comtrol ports
If a yellow exclamation mark represents the port, right-click 
on the exclamation mark, and click Update Driver. See 
Updating the Driver on Page 21 for detailed procedures.

Monitor Port 
Activity? Install the Comtrol Utility (Page 53) and use Port Monitor.

Enable Verbose 
mode

You can optionally enable the Verbose Event Log option on 
the Device General tab for diagnostic purposes to initiate 
longer messages to be sent to the Event Log for your 
operating system. The added information can be useful 
when debugging communications and configuration 
problems.
Access the event log through the Administrative Tools Event 
Viewer option.

Issue Troubleshooting
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Comtrol Utility

The Comtrol Utility Package is innovative software for serial port communication, 
testing, monitoring and reporting for the RocketPort families.
The Comtrol Utility Package contains three useful software applications named 
Test Terminal, Port Monitor, and Peer Tracer for communicating directly, 
monitoring, and reporting statistics of any COM, RS-232, RS-422, and RS-485 
serial ports you have installed in a system.
The Comtrol Utility Package supports the following operating systems:
• Windows 2000
• Windows XP
• Windows Server 2003
• Windows Vista
• Windows Server 2008
• Windows 7
The Comtrol Utility is available on the Software and Documentation CD or you 
can download the latest version from: ftp://ftp.comtrol.com/utilities/windows/
comtrol_utility. 
This subsection discusses the following topics:
• Installing the Comtrol Utility on Page 53
• Using Port Monitor (PMon2) on Page 55
• Using Test Terminal on Page 58

Installing the 
Comtrol Utility

Use the following procedure to install the Comtrol Utility package.
1. Execute the Comtrol_Utility_Package_x.xx.msi file, where x_xx is the Comtrol 

Utility version number.
2. Click Next.
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3. Click Next. 

4. Click Install.

5. Click Finish.
It is not necessary to 
reboot the PC after 
installation.

6. Go to Using Port Monitor 
(PMon2) on Page 55 or 
Using Test Terminal on 
Page 58 for procedures on 
using these applications.
Note: See Verifying and 

Testing 
RocketModem IV 
Adapters on Page 
35 to test 
RocketModem IV 
ports.
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Using Port Monitor 
(PMon2)

This procedure will check whether the RocketPort can:
• Communicate through the RocketPort device driver 
• Determine if a port is open with an application

Testing Comtrol 
COM Ports 

If necessary, use Installing the Comtrol Utility on Page 53 to install Port Monitor.
1. Start Port Monitor, from the Start menu, select Programs > Comtrol > Utilities > 

Port Monitor (PMon2).

2. Click Add Ports using the icon or Tools > Add Ports, 

3. Click Driver, the appropriate 
product (or products), and click 
Ok.
• RocketPort EXPRESS/

INFINITY: click 
ROCKETPORT INFINITY

• DeviceMaster: click RPSHSI/
NSLINK

• RocketPort and 
RocketModem (Universal 
PCI): click ROCKETPORT
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4. If the RocketPort is communicating with the device driver for Windows, Port 
Monitor should display CLOSED status. If a port is open for an application, it 
displays as OPEN, and displays Actual Throughput, TxTotal and RxTotal 
statistics. 

Normally, there should be no data errors recorded or they should be very 
small. To find out what the actual errors are, scroll to the right. You will see 
three columns: Overrun Errors, Framing Errors, and Parity Errors.
If the errors are:
• Overrun Errors represent receive buffer overflow errors. If this is the case, 

you will have to configure either software or hardware handshaking to 
control the flow of data. The most common errors are Overrun errors.

• Framing Errors indicate that there is an synchronization error between the 
beginning of a data frame and the end of the data frame. A frame usually 
consists of a start bit, 8 data bits, and a stop bit or two. The framing error 
occurs if the stop bit is not detected or it occurs in the wrong time frame. 
Most causes for framing errors are electrical noise on the data lines, or 
differences in the data clocks of the RocketPort and the connected device.

• Parity Errors occur when parity is used and the parity bit is not what is 
expected. This can also be caused by noise on the data lines.

5. You can view additional statistics to Port Monitor by adding columns. Click 
Tools and Add Columns.
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6. Highlight or shift-click to add multiple statistics and click Ok.

Note: See the Port Monitor help system if you need an explanation of a 
column.

7. Scroll to the right to view the new columns. 

8. If you want to capture this session, you can save a current session as a report. 
To do this, select one of the following save options:
• File > Save As 
• File > Save - if the report already exists in an older format

• Save Active Session  button

Reports can be opened, viewed and re-used when needed. To open and view a 
report: 
a. Select File > Open or the Open Existing Session  button. The Open 

Session dialog appears.
b. Locate the session (table), you want to open and click the Open button.
Optionally, if you want to continue monitoring for an existing session, you 
need to activate the Polling Interval. 
• Select Tools > Settings to access the PMon2 Settings dialog
• Change the Polling Interval field to a value other than zero (0)

9. Leave Port Monitor open so that you can review events when using Test 
Terminal to test a port or ports.
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Using Test Terminal Test Terminal (WCom2) allows you to open a port, send characters and commands 
to the port, and toggle the control signals. This application can be used to 
troubleshoot communications on a port-by-port basis. 
Note: See Verifying and Testing RocketModem IV Adapters on Page 35 to test 

RocketModem IV ports.
• Send and Receive Test Data: This sends data out the transmit line to the 

loopback plug, which has the transmit and receive pins connected thus 
sending the data back through the Rx line to Test Terminal, which then 
displays the received data in the terminal window for that port. This test is 
only testing the Tx and Rx signal lines and nothing else. This test works in 
either RS-232 or RS-422 modes as both modes have transmit and receive 
capability. A failure in this test will essentially prevent the port from working 
in any manner.

• Loopback Test: This tests all of the modem control signals such as RTS, DTR, 
CTS, DSR, CD, and RI along with the Tx and Rx signals. When a signal is 
made HI in one line the corresponding signal line indicates this. The Loopback 
Test changes the state of the lines and looks for the corresponding state 
change. If it successfully recognizes all of these changes, the port passes. 
A failure on this test is not necessarily critical as it will depend on what is 
connected and how many signal lines are in use. For example, if you are using 
RS-232 in 3-wire mode (Transmit, Receive and Ground) a failure will cause no 
discernible issue since the other signals are not being used. If the port is 
configured for use as either RS-422 or RS-485 this test will fail and is expected 
to fail since RS-422 and RS-485 do not have the modem control signals that 
are present in RS-232 for which this test is designed.

The following procedures require a loopback plug to be placed on the port or ports 
that you want to test. A loopback plug was shipped with your RocketPort. If you 
need to build a replacement or additional loopback plugs, refer to the appropriate 
User Guide for your Comtrol device. See Downloading the Latest Software and 
User Guides on Page 7, if you need to build loopback plugs.

Opening Ports The following procedure shows how to use Test Terminal to send and receive test 
data to the serial ports. If necessary, use Comtrol Utility on Page 9 or PortVision 
Plus on Page 13 to install Test Terminal.
1. Stop all applications that may be accessing the ports such as RRAS or any 

faxing, or production software. See the appropriate help systems or manuals 
for instructions on stopping these services or applications. 
If another application is controlling the port, then Test Terminal will be unable 
to open the port and an error message will be shown.

2. Start Test Terminal (WCom2), from the Start menu, select Programs > Comtrol 
> Utilities > Test Terminal (WCom2).
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3. Select File > Open Port, the 
appropriate port (or ports) 
from the Open Ports drop-
down list and click Ok.
Note: If you left Port Monitor 

open from the previous 
subsection, you should 
show that the port is 
open.

Go to the next procedure to send 
and receive test data.

Sending and 
Receiving Test Data 
(RS-232/422 and 
RS-485: 4-Wire)

You can use this procedure to send and receive test data through the port or ports 
that you want to test.
1. If you have not done so, perform Steps 1 through 2 on Page 58.
2. Install the loopback plug onto the port (or ports) that you want to test.

See Downloading the Latest Software and User Guides on Page 7 if you need to 
build loopback plugs.

3. Select Port > Send and Receive Test Data.
You should see the 
alphabet scrolling 
across the port. If so, 
then the port installed 
properly and is 
operational. 
Note: If you left Port 

Monitor 
running, it 
should show 
data sent and 
received and 
show the 
average data 
throughput on 
the port.

4. Select Port > Send and 
Receive Test Data to stop 
the scrolling data.

5. You can go to the next 
procedure to run the Loopback Test on Page 60 if this is an RS-232 port.

If this test successfully completed, then the port is operational as expected.
Note: Do NOT forget to restart the communications application.
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Loopback Test (RS-
232)

The Loopback Test tests the modem control (hardware handshaking) signals. It 
only has meaning in RS-232 mode on serial connector interfaces with full RS-232 
signals. If performed under the following conditions, the test will always fail 
because full modem control signals are not present:
• RS-422
• RS-485
• RJ11 connectors
Use the following steps to run the Loopback Test.
1. If necessary, start Test Terminal (Page 58, Steps 1 through  2).
2. Click Port > Loopback Test.

This is a pass fail test and will take a second or two to complete. Repeat for 
each port that needs testing.

If the Loopback Test and the Send and Receive Test Data tests successfully 
complete, then the port is operational as expected.

Sending and 
Receiving Data (RS-
485: 2-Wire)

This procedure shows how to use Test Terminal (WCom2) to test two RS-485 (2-
wire, half-duplex) ports.
1. Start Test Terminal.
2. Open two ports RS-485 ports. This example uses COM40 and COM41.
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Test Terminal will open two windows, note that both ports show Receiving on 
the status bar.

3. Right-click both COM windows and remove the check mark for Receive.
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Both COM ports show Ready on the status bar.

4. Right-click in ONE window and select the Receive option from the pop up.
5. Right-click the OPPOSITE window and click Send.

The Status line shows Sending or Receiving.
In this case, COM40 is sending data and COM41 is receiving the data which is 
visually confirmed by the data scrolling across the COM41 window.
Note: If you do not see the data being received it MAY be necessary to also 

disable the RTS and DTR options from the right-click pop-up menu in 
each COM port.

6. Right-click and remove the check mark on the Sending COM port.
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7. Right-click and remove the check mark on the Receiving COM port.

Neither COM port is sending or receiving data but shows Ready on the Status 
bar.

8. Reverse the sending/receiving windows one at a time. Set the Receive option 
first, then in the opposite window, select the Send option.
The Status line shows Sending or Receiving in the reverse windows.

Data is now scrolling in the COM40 window. COM41 is static as it is not receiving 
data but transmitting data.

Before Calling Technical Support

Comtrol has a staff of support technicians available to help you. You should review 
Troubleshooting Checklist on Page 51 before calling Technical Support. If you call 
for Technical Support, please have the following information available.

Item Information

Adapter type

Adapter serial number

Driver part number and 
revision or version

Server computer make, 
model, and speed

Other serial port adapters 
installed in the server and 
their COM port numbers

Devices connected to the 
adapter
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Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Contact Method Corporate Headquarters

Support http://www.comtrol.com/pub/en/Support

Downloads ftp://ftp.comtrol.com/html/default.htm

Web site http://www.comtrol.com

Phone
763. 957.6000
CST: 8AM-6PM (Excluding US Holidays)
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Configuring Non-Plug and Play Devices

After installing the hardware and driver for Windows operating systems, you can 
use this discussion to configure non-plug and play COM ports.

Installing Non-Plug and Play Devices

Use the following procedure to install non-plug and play devices.
1. If you have not so yet, connect the device to a RocketPort port and turn on the 

device.
2. Open the Control Panel.
3. Go to the appropriate subsection to install non-plug and play modems or 

printers:
• Installing Modems on Page 79
• Installing Printers on Page 80

Installing Modems Use the following procedure to install non-plug and play modems.
1. If you have not done so yet, connect the modem (or modems) to the desired 

RocketPort port (or ports) and turn on the modem (or modems).
Note: This may take a few minutes, depending upon your system and the 

number of modems you are installing.
2. Open the Control Panel and click the Phone and Modem Options icon.
3. Click the Modems tab.
4. Click Add.
5. Click Don’t detect my modem. I will select it from a list and then click Next.
6. Click an appropriate modem model and then click Next.

Note: If you have a driver from the modem manufacturer, click Have Disk and 
browse to the location of the driver. If your modem is not listed, go to the 
modem manufacturer’s web site and download the appropriate driver.

7. Highlight the port or ports on to which you have connected modems.
8. Click Finish to complete the modem installation.
9. Configure modem properties as necessary. For assistance, use the Windows 

help system.
To use this modem or modems with RRAS, you can refer to the Comtrol RRAS 
Configuration Overview for Windows XP document.
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Installing Printers Use the following procedure to install a non-plug and play printer.
Note: If you want to install a plug and play printer, connect the printer to the 

appropriate serial port and the driver should automatically install. If it 
does not automatically install, use the following procedure as a guide with 
the printer manufacturers documentation.

1. Open the Control Panel and click the Printers and Faxes icon.
2. Click Next when this screen appears.
3. Click the Local printer attached to this computer item.
4. Click the COM port that corresponds to the port to which the printer is 

connected.
5. Click the Manufacturer, Printer type, and then click Next. 

Note: If you have a driver from the printer manufacturer, click Have Disk and 
browse to the location of the driver. If your printer is not listed, go to the 
printer manufacturer’s web site and download the appropriate driver.

6. Optionally, enter a printer name and then click Next.
7. Click Yes if you want to print a test page.
8. Click Finish to complete the installation.
9. Close the Printer and Faxes Control Panel.
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